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1 General comments 

This document covers QlikView build 11.2.12902, Service Release 12. Information about QlikView 11.2 

SR1-SR6 are not included, but can be found in the SR6 Release Note. 

The release contains components of QlikView Desktop, QlikView OCX, QlikView Server, QlikView 

Publisher, QlikView Webparts for Microsoft SharePoint(R), QlikView Workbench and all clients except 

clients for mobile devices. 

1.1 Important security information regarding QV11.20 SR12 

A security vulnerability related to XML handling in QlikView has been found, special thank you to Alex 

Haynes, IT security analyst at Vente Privée for reporting. We recommend that you assess this 

vulnerability in your QlikView deployment. A fix is provided in QlikView Server version 11.20 SR12 

which we recommend all customers apply to alleviate this issue. Please contact Support if you have any 

questions. 

1.2 New in QV11.2 SR11 

1.2.1 Errors in Expressions - syntax errors displayed in chart objects which previously 

did not show an error 

As a result of fixing bug 69228 “Syntax checker not working”, syntax error messages in object 

expressions are now returned to objects instead of returned as NULL.   This may result in an object 

which rendered in SR10 or earlier, displaying an error message in SR11 (”Error in expression”).  In 

addition, QlikView Server will generate an error message in the QlikView Server event log every time a 

faulty expression is evaluated. To avoid disruption in existing production environments and potentially 

large growth in event log file size, this will only be ON in QlikView Desktop and by default turned OFF 

in QlikView Server.  

You are able to turn this ON by adding SilentErrorInChart=0 to the Settings.ini file for QlikView 

Server (C:\ProgramData\QlikTech\QlikViewServer).    We recommend that in test/development/QA 

environments that this setting is turned ON so that errors in expressions are logged and faulty 

expressions can be identified and corrected.   Errors will be logged in the QlikView Server Events log 

only if SilentErrorInChart=0, an example log entry is below: 

Error SE_LOG: Expression Error. Doc: S&D Dashboard.qvw, ObjectId: Document\CH14, Expr(4). 

1.2.2 QVS stability 

A number of improvements have been made and several bugs have been fixed regarding QVS stability, 

both in single and clustered environments. The improvements will be most noticeable in high-pressure 

clustered scenarios. 

1.2.3 QVS stability 

A number of improvements have been made and several bugs have been fixed regarding QVS stability, 

both in single and clustered environments. The improvements will be most noticeable in high-pressure 

clustered scenarios. 

1.2.4 QDS improvements 

A number of improvements regarding QDS reliability in clustered environments. We recommend all 

customers with clustered QDS environments to upgrade. 

1.2.5 Support for Internet Explorer Touch 

Touch mode on tablets or hybrid computers with Internet Explorer should now have the same 

functionality as Safari and Chrome. 

http://fr.vente-privee.com/
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1.2.6 Direct Discovery Sub queries 

Additional capability has been added in the cases where more than one table/view within the application 

is in Direct Discovery mode.  A new Set statement can be used: 

 

SET DirectEnableSubquery='true';  

This will invoke SQL sub queries to be generated when filters are applied to a table which involves 

limiting the dataset in another associated direct discovery table (without this a large IN clause may be 

generated) 

The following limitations apply when using subqueries: 

Subquery syntax is only invoked when you select data which involves filtering a chart using data from 

another table. 

The amount of data within the keys is the determining factor, not the number of keys. 

Subqueries are only invoked if all tables involved are in Direct Discovery mode. If you filter the chart 

using data from a table included in memory mode, an IN clause will be generated. 

1.2.7 Possibility to turnoff “Execute” command in Publisher 

As a security feature, it is now possible to turn off the ability to use “Execute” command in a script. A 

new setting, AllowExecuteCommand, which by default is set to 1 is included in the QVB settings.ini file. 

This is located in the file path: 

"C:\Windows\System32\config\systemprofile\AppData\Roaming\QlikTech\QlikViewBatch".  

Changing this setting to 0 will cause any Publisher task with an “Execute command” in the script to fail. 

This setting has to be done on all nodes in a QDS cluster. 

1.2.8 New API call for load balancing in QVS cluster 

The new method allows the caller to find the address of the QVS that currently is most suitable for 

opening the specified document according to the load balancing settings of the given QV Web Server. 

This is to be used when building solutions that is not going through the AccessPoint 

New QMS API method call: 

Uri SelectServer(Guid qvwsID, string document); 

Example: 

ServiceInfo[] qvsServices = qms.GetServices(ServiceTypes.QlikViewWebServer); 

Guid serverID = qvsServices[0].ID; 

Uri serverURI = qms.SelectServer(serverID, "MyDocumentName"); 

1.3 New in QV11.2 SR10 

1.3.1 New Pie chart color option 

Now possible to define color of the lines around the sectors in a Pie chart. In the properties Color tab of 

the chart, you can now find the Sector outline property. Please note that calculated colors do not work for 

this setting. 

1.4 New in QV11.2 SR9 

1.4.1 iOS8 Safari support 

This release now supports iOS8.1 with Safari/AJAX use. Due to several issues in iOS8.0, this will not be 

supported. Our native iOS apps are currently being adapted for iOS8. 
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1.4.2 New Trigger option in QMC 

When configuring a trigger for a task in the QMC, you now a new option available. Previously you could 

choose Once/Hourly/Daily/Weekly/Monthly, now also “Continuously” is added. Choosing this option 

will restart the task as soon as it has finished.  

1.5 New in QV11.2 SR8 

This release includes the following major changes: 

1.5.1 New Client language: Polish 

The AJAX Help will be included in SR9. 

1.5.2 Configurable AJAX  

Configurable Ajax Messages  

Some of the messages sent in the AJAX client can now be configured to your own wording or translated 

to another language.  

You can change these messages in the file "customTranslations.js" supplied in the "Program 

Files\QlikView\Server\QlikViewClients\QlikViewAjax\htc\customFiles" folder on the machine where 

the QV WebServer runs.  

 

A file named customTranslationsExample.js is also provided that shows syntax and which messages that 

can be configured. 

Configurable Ajax functions 

For new or changed functionality in the AJAX client we will in future releases try to provide a 

mechanism where you can choose to turn these functions/changes On or Off. 

This configuration file is named customConfig.js and placed in “Program 

Files\QlikView\Server\QlikViewClients\QlikViewAjax\htc\customFiles " folder on the machine where 

the QV WebServer runs.  

A file named customConfigExample.js is also provided that shows syntax and which functions/changes 

that can be configured. 

Currently these features are configurable: 

- TranslationEvents (see above Configurable Ajax Messages, default ON) 

- MultiselectCalendar (possibility to select more than one day in Calendar object, default ON) 

- InputDeviceRotator (possibility to switch between Mouse/Touch input on hybrid devices, default ON) 

 

1.5.3 Alternate state parameter for certain functions 

New parameter added to the functions “GetSelectedCount()”, “GetFieldSelections()” and 

“GetCurrentSelections()” to query other states than the main state. 

E.g. =GetFieldSelections(Quantity, ';', ,'StateA')  

 

1.6 New in QV11.2 SR7 

This release includes the following major changes: 
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1.6.1 Windows XP / Vista and Internet Explorer 6 & 7 

Since Microsoft has stopped their support of Windows XP on the 14th of April we have decided to 

remove Windows XP from our list of supported platforms. At the same time we decided to remove 

Windows Vista and Internet Explorer 6 & 7 from the list due to low usage in our customer base. The 

product will still be installable on both XP and Vista and you can still report issues, but these issues will 

most likely get low priority. 

1.6.2 Direct Discovery Enhancements 

3 key features have been added to this release: 

 Support for multi-table queries 

o Direct Discovery can be used to load more than one table/view and supports ANSI 

SQL join functionality.  A limitation exists in the fact that in a single chart all measures 

must be derived from the same logical table in QlikView, this could in fact be a 

combination of tables from source linked via join statements. 

 Support for server side section access 

 Support for Teradata Query banding 

 

1.6.3 Task performance summary 

New task performance summary added that will provide information about the amount of RAM 

used, CPU and QVB elapsed time.  

Information is to be to be used for planning and troubleshooting purposes.  

RAM information 

Peak RAM:  

 -           The highest amount of consumed RAM during the task run, divided into physical 

and virtual.  

Total peak RAM: 

 -           The highest amount of consumed RAM during the task run for all processes 

combined on the machine, divided into physical and virtual. 

Average RAM 

 -          The average value of RAM used for the task, divided into physical and virtual. 

CPU information 

QVB peak CPU: 

 -          The highest amount of consumed CPU during the task run used by the task 

process (QVB).   

Total peak CPU: 

 -          The highest amount of consumed CPU ran during the task for all processes on the 

machine.   

Average CPU: 

 -          The average CPU usage for the task, shown as a percentage.  

Elapsed time: 

 -          Log the elapsed time run for the QVB. 
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Setting up: 

The task performance summary can be activated by setting the EnableQVBProcessSummary 

to 1 in the QVB Settings.ini file.  

Default location of the QVB Settings.ini file: 

C:\Windows\system32\config\systemprofile\AppData\Roaming\QlikTech\QlikViewBatch 

Note: The last row in the ini file needs to be blank.  

 

 

1.6.4 Support for document administrator group with cross domain groups 

Starting with v11.20 SR7 it will be possible to use the document administrator group in setups 

involving multiple domains.  

Note:  

Using multiplied domains can result in a performance impact, where the use of cache is 

recommended.   

How to use cache: 

Add/Change configuration key in QVManagementService.exe.config 

<!-- DocumentFolder Admin Cache Enabled --> 

<add key="DocumentFolderAdminCacheEnabled" value="true" /> 

<!-- DocumentFolder Admin Cache Expiry in minutes --> 

<add key="DocumentFolderAdminCacheExpiryMinutes" value="15" /> 

 

1.6.5 CAL allocation audit added to QlikView server event log 

Information of which administrator that adds or removes a CAL has been added to the QlikView 

server log file. 

 

1.6.6 Support to get Session and Usage CAL information using API 

Adds support to use the API to get information regarding the Session and Usage CAL ex. 

LastUsed, MachineID, UserName, QuarantinedUntil (when applicable).  

Note: 

An update of the service reference could be needed when upgrading from a previous version to 

enable the new values. 

 

1.7 Cross-release compatibility 

It is not possible to have multiple versions of QlikView Desktop installed, i.e. the QlikView 11.2 

Desktop installer will overwrite a QlikView 10 Desktop installation. However, the QlikView 11.2 

Desktop executable file can be copied to any location on the hard drive and run from there without 

conflicting with the installed QlikView version.  

In order to run multiple versions of QlikView Desktop on a single machine, please follow this 

procedure: 
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1. Uninstall prior version 

2. Install QlikView Desktop v11.2 

3. Copy the QV.exe file to a new, safe location 

4. Uninstall QlikView Desktop v11.2 

5. Install prior version  

Following this procedure, you end up with a working version 11.2 QV.exe, but the operating system 

treats the prior version as your primary version of QlikView. 

QlikView 11.2 has a file format compatible with versions 9, 10 and 11. 

The QlikView Plug-In client is automatically installed with QlikView Desktop. If the version of either 

client is changed, it is recommended to do an uninstall of the previous version before installing another 

version. If any of the installations become unstable, they can be corrected by repairing the affected 

installation. 

QlikView 9 Workbench and QlikView 9 WebParts are not compatible with QlikView 11.2. 

1.8 Installation programs 

The QlikView Server installation program installs QlikView Server and QlikView Publisher. 

The QlikView Desktop installation program installs QlikView Desktop and QlikView Plug-in for 

Microsoft Internet Explorer by default. To install the Plug-in only, run the QlikView Desktop installation 

using the custom setup option and select QlikView OCX only. A separate installation program for 

QlikView Plug-in for Microsoft Internet Explorer is included in the QlikView Server install.  

A 64-bit version of the QlikView Plug-In is included in the 64-bit QlikView Desktop installation 

program. Follow the procedure above to install the 64-bit Plug-in. There is not a separate install program 

for the 64-bit Plug-in. 

QlikView Documentation and Tutorial, QlikView Web Parts for Microsoft SharePoint(R) and QlikView 

Workbench are delivered in separate installation programs. 

1.9 Support material 

The new features in QlikView 11.2 are documented in the PDF reference manual and in the help files 

that can be found in the separate installation packages.  
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2 Comments on product features  

The following features are conscious design decisions and most of them are not likely to change in 

coming Service Releases. 

2.1 Server installation 

 It is not possible to install the QlikView Server on a domain controller. 

2.2 Clients, Presentation, Layout & Charts 

 If data with over 2,147,483,647 unique values is loaded, QV does not load correctly. Also, after 

2,147,483,647, the value turns negative as the data is displayed in record number in a statistic 

box. 

 Dimension limits should not be used in tables that contain mini-charts. This will cause an out of 

memory error. 

 The security settings of Internet Explorer may prevent users from exporting data or sending data 

to Excel when using the plug-in client. The workaround is to add the QlikView server to the 

trusted sites list or modify the security settings under Internet Options to allow launching of 

external applications. In addition, ensuring the Enable Protected Mode check box is unchecked 

may also be necessary. 

 AJAX for Small Devices mode is not compatible with Private Browsing in iOS5. In order to 

have the full functionality of the client you must turn off Private Browsing in Safari. 

 On systems using UAC (Windows user access control), WebView may require that QlikView is 

started using the “Run as Administrator” option. 

 The AJAX client will ignore all scroll bar settings except widths. 

 The AJAX client does not allow users to change scroll bar settings. 

 OnActivate and OnDeactivate Sheet Object Event triggers have been removed from QlikView 

11 and later. The sheet level triggers are still available though, only the object level has been 

removed. 

 The Activate and ActivateAll API methods no longer work since the OnActivate and 

OnDeactivate object triggers have been removed. 

 The new, scrollable tab row is not available in Internet Explorer 8 and lower or in older versions 

of other browsers. In older browsers, the original tab row will be used. 

 Beacons are not displayed in the new (scrollable) tab row. 

 The vertical label setting on Pivot and Straight tables has no effect in AJAX. 

 Prior to QlikView 11 some graphical charts allow an 'others' segment. When these charts are 

opened in QlikView 11, the X-axis presentation limit and the label are moved to the proper 

places on the Dimension Limits tab. This is not the case with straight tables. The label will be 

moved to the Dimension Limits tab but the Max Number of Rows value will remain as it was. 

 There is no ‘undo’ functionality on Notes and Comments. If a Note is deleted, it is permanently 

removed. If an object with Notes is deleted, all of the Notes and Comments for that object will 

be permanently deleted even though it is possible to undo the deletion of the object. 

 Graphical charts with ‘Max Visible Number’ set in version 10 and older will have this setting 

migrated to the new Dimension Limits tab in the property dialog. The new settings will be to 

‘Show Only’ using the ‘Largest’ values 

 The default significant digits have gone from 8 to 14. This only affects list boxes and 

expressions that have not been reformatted from Expression Default. 
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 The Menu option and Dialog box for interacting with Server objects have been removed. The 

View | Show Server Objects menu commands should be used to interact with server objects. 

 Suppress Zeroes is not being done in Pie and Funnel charts. Zero values were 

previously suppressed in the front end for expressions in these two charts. With the addition of 

Dimension Limits, QlikView will no longer suppress zero values for expressions across all chart 

types. This will affect charts that have only expressions and no dimensions. Zero values caused 

by dimensions will still be suppressed as before when the option is enabled. 

 Scrollbars in AJAX do not respect changes in the settings. This is because we have changed the 

way scrollbars are rendered in AJAX. 

 There is no way to choose/upload an image for Backgrounds or Dynamic Backgrounds in the 

AJAX client. 

2.3 Script, ETL and Expressions 

 The script parser no longer accepts incomplete quotes (or brackets) around file names. 

 The default color scheme for script and expression syntax has been changed. 

 On 64-bit systems, 64 and 32-bit QlikView loads both 64 and 32-bit custom connectors. 

QlikView first looks for 64-bit connectors in the current QV.exe location and then in “Program 

Files/Common Files/QlikTech/Custom Data”. Further, QlikView looks for 32-bit connectors in 

the current QV.exe location and then in “Program Files (x86)/Common Files/QlikTech/Custom 

Data”. If several connectors with the same file name are found only the first one is included into 

the connector list.  

 The macro script debugger is no longer in QlikView. The product is no longer supported by 

Microsoft. 

2.4 Documentation & localization 

 WebView help is not completely context-sensitive like the rest of the help. The help will react 

to the currently selected object but not the properties within the object. The help can be opened 

from the Help menu or from within the regular QlikView help. 

 QlikView documentation is no longer stored in C:\Program Files\QlikView. Documentation is 

now stored in C:\ProgramData\QlikTech\QlikView Documentation. In XP and Server 2003, it is 

C:\Documents and Settings\All Users\Application Data\QlikTech\QlikView Documentation 

2.5 QlikView Server, QlikView Publisher and Management Consoles 

 “Due to a limitation associated with using Microsoft’s COM objects we recommend that you 

limit the number of QlikView Engines (QlikView Enterprise Management Console>> 

System>> Setup>> Distribution Services>> Advanced tab) to a maximum of 9 or the number of 

processor cores available on the host server -1, whichever is lower.”  If you have more than 9 

processor cores, and wish to run more Engines, contact Support for information regarding a 

registry change to the Desktop Memory Heap settings on the server. 

 The QlikView Server services are designed to run as local administrator. Running with an 

account that is not local administrator is an unsupported scenario. 

 To use the QlikView Management Service (QMS) API the group “QlikView Management API” 

must be created as a local security group on the QMS machine and the account that uses the API 

must be part of that group. This will also apply to importing tasks from another QMS. There are 

two exceptions to this: 

 The API for starting an EDX task and  

 The API for getting status on an EDX task.  
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 In QlikView 11, EDX runs through the QlikView Management Service (QMS) API. This is a 

major change from QlikView 10, where EDX is realized by calls directly to a QlikView 

Distribution Service (QDS). 

 Search results may differ between two searches in a clustered Directory Services Connector 

(DSC) right after a change since each DSC caches individually. 

 When using session recovery (session recovery is only applicable for the AJAX client) there 

will be a Server bookmark in the QlikView Management Console for each user that is using a 

document. These Server Bookmarks will reappear in the QMC even if deleted because they are 

generated by QlikView to handle session recovery. 

 When losing the network connection - even briefly - there will be errors in the task logs and 

event log. 

 When using Session Collaboration, invitees have the same data access privileges as the session 

initiator. 

 QlikView cannot sustain the inputfields if the document is opened without data. Therefore, any 

document containing inputfields will always open with data, even if flagged not to do so. When 

this occurs, a line indicating this behavior will be written to the log file. 
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3 New functionality in QlikView 11.2  

3.1 Direct Discovery 

 
QlikView Direct Discovery capability combines the associative capabilities of the QlikView in-memory 

dataset with a query model where the source data is not directly loaded into the QlikView data model. 

The aggregated query result is passed back to the QlikView user interface. The Direct Discovery data set 

is still part of the associative experience where the user can navigate both on the in-memory data and the 

direct discovery data associatively.  

The QlikView Direct Discovery feature is a hybrid capability where the in-memory and direct discovery 

data sets can be analyzed together, even in the same chart. The business users can make selections on 

either of the data sets, and see what is associated and not associated with the same QlikView association 

colors; green, grey, and white. They can create charts that help them analyze data from both data sets 

together.  

This hybrid approach provides much greater power and flexibility than the data visualization tools or 

traditional query capabilities because with these tools, the users can either create extracts to an in-

memory engine or run queries on the database but cannot do both on the same application persistently.  

QlikView Direct Discovery enables users to perform business discovery and visual analysis against any 

amount of data, regardless of size. With the introduction of this unique hybrid approach, users can 

associate data stored within big data sources directly alongside additional data sources stored within the 

QlikView in-memory model. QlikView can seamlessly connect to multiple data sources together within 

the same interface, e.g. Teradata, SAP, and Google Big Query, allowing the business user to associate 

data across the data silos. 

3.1.1 Limitations  

 
Due to the interactive and SQL syntax specific nature of the Direct Discovery approaches a number of 

limitations exist.  

The following chart type is not supported;  

 Mini charts  

And the following QlikView features are not supported;  

 Advanced calculations  

 Calculated dimensions  

 Comparative Analysis (Alternate State) on the QlikView objects that use Direct Discovery fields  

 Non Dimension Direct Discovery fields are not supported on Global Search  

 Binary load from a QlikView application with a Direct Discovery table  

 Section access and data reduction  

 Loop and Reduce  

 Synthetic keys on the Direct Discovery table  

 Table naming in script does not apply to the Direct table  

 The use of “*” after DIRECT QUERY keyword on the load script (e.g. DIRECT QUERY *)  

Considerations from a security perspective.  

 All of the users using the QlikView application with the Direct Discovery capability will be using 

the same connection. With this initial release, authentication pass-through or credentials-per-

user are not supported.  
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 Section Access is not supported.  

 With the new NATIVE() expression function, it would be possible to execute custom SQL 

statements in the database. It is advised that the database connection set up in the load script 

should use an account with only read access to the database.  

 It is possible to flood the database with requests from the client.  

 It is possible to get detailed error messages from the QlikView Server log files.  

 Log files are automatically generated on the desktop if the direct query fails due to a database 

error. 
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4 Upgrading from previous QlikView versions 

4.1 QlikView Desktop 

To upgrade, previous versions of QlikView need not be uninstalled. However, the previous installation 

will be overwritten and the settings from the earlier version will be used. 

4.2 QlikView Server 

4.2.1 From QlikView 10 

To upgrade, previous versions of QlikView need not be uninstalled. However, the previous installation 

will be overwritten and the settings from the earlier version will be used. 

4.2.2 From QlikView 11 

It is recommended to uninstall earlier versions of QlikView before installing the QlikView 11.2. 
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5 Known issues 

The following issues were identified at release time. The list is not comprehensive; it does however list 

all known major issues. The ambition is to have the issues fixed in coming versions. 

5.1 Clients, Presentation, Layout & Charts 

 The Calendar object in AJAX client has been replaced in QV11.2 SR4, with a different look and 

feel, but should otherwise be fully compatible. 

 Direct Discovery issues 

o It is not recommended to use the OCX plugin in combination with Direct Discovery. 

o Direct fields do not populate system fields in the same way as in-memory fields. 

(#51841) 

o Logical data islands in the data model behave differently between Direct Discovery 

and in memory tables. (#50880)  

o Tablebox not updating when it contains only MEASURE or DETAIL fields and 

DIMENSION field clicked in Listbox 

o Cannot do a reload when app contains tablebox and textbox at the same time  

o selecting a value in a table box that is in a detail or measure field results in a X through 

the table box 

o Unexpected behavior on updating data in the source DB with a list box DIMENSION 

o If direct sql data source is down, opening a DD QVW takes several minutes 

 The Subversion wrapper has a problem with parsing different language code pages.  

 QlikView supports subversion 1.6.17 and 1.7.x. Trying to use other versions may result in 

incompatibility issues. 

 A document with input fields will create a .shared file when it is opened on an Accesspoint. Due 

to underlying data structures, the .shared file will grow with an average of 50-80 bytes/input 

field value when the input field value is changed.  

 Macros will not function in WebView. 

 QlikView 9 (Desktop and Server) cannot open documents that contain the new QlikView 11 

actions. 

 When upgrading from a prior version to QlikView 11, the internet cache should be cleared 

before the new AJAX property dialogs can be used. 

 Pressing the ‘Help’ button in the AJAX client invokes help but not context sensitive help. 

 When using QlikView Help in Firefox (AJAX), the browser window will resize (reduce in size 

or minimize). 

 When both x86 and x64 versions of QlikView Desktop are installed on a single machine an 

uninstallation of either will leave some files on the hard drive. These files can be manually 

removed. 

 When using the AJAX client in IE, list boxes with many (>50,000) items will display a white 

box instead of the values when scrolling / paging though the list. 

 The alignment options for Multi-Line captions do not work in the AJAX client in IE7. 

 Nested grid containers will expand beyond the outer container when first created in the AJAX 

client. Pressing F5 or resizing the outer container will fix the problem. 
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 The ‘Select Report’ dropdown is active in the AJAX client even if the QlikView Server does 

not allow printing. The users will not be able to print even though it appears they can. 

 QlikView 11 can open QlikView 10 project files (XML). If there was a container object in the 

original QlikView 10 file, it will be lost when opening the project files in QlikView 11. This 

will corrupt the new QlikView 11 file and the entire container will need to be reconstructed. The 

work around is to open the QlikView 10 file in QlikView 11 and recreate the project files. 

Reportedly this could happen with QlikView 11 files as well, please follow same procedure and 

re-create the project files. 

 Creating multi-column list boxes in AJAX is not working correctly. The slider to change the 

number of columns is not working. However, the user can type a number into the box next to 

the slider to change the number of columns. 

 QlikView will render graphical charts with multiple dimensions and multiple expressions (a 

combo chart with two dimensions and three expressions, for example) though the chart will not 

provide much value. Currently, QlikView will produce a ‘drawing failed internally error’ when 

trying to render graphical (not straight and pivot tables) charts with these characteristics. 

5.2 Documentation & localization 

 When adding Document Administrators, it shows in the GUI Add users and Groups, but 

security groups are not allowed as document administrators. (#52143) 

 QMC Webhelp is now available in Japanese. To replace English Webhelp with Japanese 

Webhelp, please rename the two folders (QMCHelp and QMCHelp_JPN) which you typically 

find under C:\Program Files\QlikView\Management Service. Change “QMCHelp” to 

“QMCHelp_Old” or “QMCHelp_eng” (or delete the folder if you do not need English help). 

Change “QMCHelp_JPN” to “QMCHelp” – the Japanese help files will now be accessed when 

you click the Help icon in the top corner. A PC that has displayed the English help files needs to 

empty its web cache to ensure the Japanese files are loaded. Any QlikView services running 

need to be stopped before making the changes and started again after the change was made. 

 English documentation for QlikView Desktop is included in this release. Other languages must 

be downloaded from the QlikView website. 

 It is possible to have the Help language different from the QlikView Desktop interface. This can 

be changed on the General tab of User Preferences. 

5.3 QlikView Server, QlikView Publisher and Management Console 

 

 When using Script parameters in a reload task without a loop and distribute, only one reload 

will be executed, i.e. only the first parameter value will be used. The possible workarounds are 

either to add a loop and distribute to e.g. a scrap folder, or to create one task for each value. 

 Network Storage Devices other than Microsoft Windows based shares are known to cause 

system instability and are not currently supported. 

 Running an older version (pre v11) of QlikView Server after having a v11 QlikView Server 

installed and running will disable the existing anonymous account. In order to run the older 

version of QlikView Server, the anonymous account must be enabled BEFORE starting the 

older QlikView Server. 

 The suggested filename when downloading from the AccessPoint may have non Western 

European characters replaced by underscores in browsers that do not support UTF-8 headers.  

 If QlikView Server isn’t allowed to disable the anonymous account it will still try every time it 

starts. 
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 It is possible to enter more text in document description than will be visible in the Access Point 

5.4 QlikView Workbench 

 In some situations it may not be possible to edit the properties of an Extension Object created 

with the Extension Wizard. 

 Some of the extension examples use direct links to /QvAjaxZfc/ instead of relative links. This 

will cause these examples to fail in Workbench (and Web Parts). To make them work 

LoadExtensionScripts LoadCSS should be used. E.g.: 

 

Qva.LoadScript("/QvAjaxZfc/QvsViewClient.aspx?public=only&name=Extensio

ns/QlikView/Examples/geoHeat/raphael.js", geoHeat_Example_Done); 

changed to: 

Qv.LoadExtensionScripts(["Extensions/QlikView/Examples/geoHeat/raphael.

js"], geoHeat_Example_Done); 

and: 

Qva.LoadCSS("/QvAjaxZfc/QvsViewClient.aspx?public=only&name=Extensions/

QlikView/Examples/org/main.css"); 

changed to: 

Qva.LoadCSS(Qva.Remote + (Qva.Remote.indexOf('?') >= 0 ? '&' : '?') + 

'public=only' + '&name=' + 

"Extensions/QlikView/Examples/piechartlabel/style.css"); 
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6 Bugs corrected in QV11.2 SR12 

ID Title 

70426 XML attack preventor 

70441 Chart: Sort on Y value option is missing 

70448 QMC: Unable to search with * (not wildcard search) in Manage Users 

70449 PGO watchdog should be disabled for single node installations 

70451 Sync of settings among nodes in a QVS cluster doesn't work if a node fails to acquire a 
crypto service provider from Windows 

70463 Pivot Table: Values not shown when previous dimension values are null 

70464 Direct Discovery on QlikView 11.20 SR 11 not working when access via AccessPoint 

70488 Different Chart Property menu between SR10 and SR11 

70490 Sort by Freq has changed from earlier versions 

70502 Direct Discovery on QlikViewServer can fetch all the data 
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7 Bugs corrected in QV11.2 SR11 

ID Title 

42584 iPad - Scrollbar - 'Chart Pivot table' object touching scroll issue 

46614 Pie Chart: Slice size is not correct 

48512 Section Access: Objects in Containers show headers (labels) even though Section 
Access should prevent user seeing the object 

50323 Y-axis doesn't show proper number format in combo chart when one expression value 
is empty 

53687 Chart object: Expression editor indicates false error when using implicit exclusion 

54614 IE Plugin: IE hangs when adding a new sheet object with Plugin 11.20 on QVS 11 SR2 

54918 QlikView IE Plugin does not validate Expression, always shown as "Expression OK" 

55330 QlikView Developer: Using advanced search from the Edit menu crashes QlikView. 

55684 Memory Statistics output "-1.#J" as Size 

55717 Desktop WebView Calendar object dropdown "Unexpected exception occurred!" 

55756 Plugin: QVPlugin crashes when changing tabs from left to right or other way around 

56120 IEPlugin Auto-Ascending for List Box is Active Without Scroll Bar if Session is 
Established during Reload 

56223 Linechart limited by static max value not rendered as expected 

56263 QlikView Manual should warn users that creating large table boxes can lead to 
unrestricted memory growth 

57230 Using a QVS cluster for WorkBench delays load from second QVS node 

57382 WebView: copied objects almost invisible when minimized 

57494 Cycle button breaks 

58199 Current selections box not showing all the current selections through IE-plugin 

58207 Security: Save Documents (user) disabled for admin users 

58579 Pivot and Straight table data not updated when opened via AJAX 

59323 Performance degrade when opening document QV10 vs QV11.20 

59500 Chart expression image not working in 11.20 SR1 Server when viewed from Chrome or 
Firefox browser 

59973 List Box: error when combining "Set Analysis" and "AND mode" 

60503 Stock chart line does not update when scrolling X-axis 

60647 Google Maps does not work with Fire Fox/Chromes 

61300 iOS - Safari - Direct Link - Login - Logging into iOS Safari 6.1.3 through a direct link and 
canceling the log will make a prompt come up and won’t go away 

61310 Sheet objects disappear after making selection. 

61609 QvAjax.js error if Null value is selected in AJAX 

61927 OCX license does not to show up in CTRL + Shift + Q menu 

62135 Ajax/WebView: Dimension in Pivot table doesn't display text as Vertical when pivoted 

62258 Pivot table: Cyclic work and Enable Conditional mot working in some scenarios 

62352 Desktop: Cyclic/Drill-down icon is displayed wrong if there is a conditional dimension. 

62473 Multibox list on Ajax does not show data when switching contracts 

62543 Ajax: Text Object in Container Object with Background - Image doesn't work properly 

62605 AJAX: using special character chr(11) does not work 

62638 Objects list not displayed in Container Properties 

62771 Pivot table properties in Ajax/WebView, Edit Expression (>Caption>Label>Edit 
Expression) need 2 clicks to be opened. 

62880 SalesForce Connector login fail when password string contain "<" 
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63101 QlikView desktop crashes when accessing properties of server object 

63145 AJAX Scrollbar color property has no effect. 

63238 Document Bug: Full Accumulation doesn't work if Dimension has null value 

63275 Desktop client - Bar chart with X-axis scrollbar activated and set "When number of 
items exceeds" < 6 does not work as expected 

63480 Chart scrolling reversed not working in WebView with cyclic group - C++ 

63587 Desktop - Extra space in bar chart 

63685 AJAX: Field search dropdown in straight table not aligned when using Chrome 

64008 Desktop/IEPlugin: Associated/Excluded values are not filtered by selections 

64141 Popup for text too long not displayed in AJAX 

64519 Container Object - Pivot Table  - AJAX - Pivot Table will randomly disappear when in a 
container object when selecting other pivot tables in the container object, but will 
reappear when you click off and go back 

64910 Bar Chart: 2nd Dimension's legend shows labels of expressions (measures) if 1st 
dimension's legend is off 

65279 Desktop Client: Chart x-Axis Scrollbar + Reversed not working as expected 

65354 Expand/collapse ICONs in pivot table do not work correctly sometimes 

65483 Slow Performance Ajax IE9 

65640 Search doesn't work correctly with Japanese in iPad/iPhone 

65681 QlikView developer - QVD - TAG: TAGs do not update correctly within a QVD. 

65695 Ajax/WebView: Headers disappear when scrolling vertically a straight table  with the 
Horizontal property selected 

65791 Sideways scrolling does not work on straight table when the table has only 1 record 

65821 Export to Excel from pivot table changes Date settings 

65838 Stacked 3D Bar Chart : Expression-axis shows only 2/3 when filtered by dimension-axis 

65972 .xml of 0kb gets created in the taskresult folder when task is disabled but has an active 
trigger 

66023 Different special characters (TAB, SUBSTITUDE) stop documents from loading in AJAX 

66060 QV11.20SR2: Ajax Tooltips get truncated 

66068 Desktop: Dragging dimension causes memory-exceeded in Pivot table 

66444 Bar chart: Axis scale not adjusting to expression values 

66531 Scatter chart: No  label on  X-Axis when scaling number turns in 1E+042 notation 

66618 Chrome Table Box Drop down display issue 

66619 AJAX search Box issue 

66698 ORDER BY doesn't sort "a"17 digit value 

66915 QlikView picks the wrong windows default printer under certain circumstances 

66954 Bar chart: dimensional bar is not displayed if Bar distance is set in negative value 

67007 Number in Axis in chart is not displayed correctly 

67022 Chrome browser: Long attribute name makes the "value" field disappear in 
AccessPoint 

67070 Server is not logging object extension errors (C++) 

67073 Listbox, looks different in IE9, 10 than in IE8. 

67132 'Show alternatives' options not highlighted in ListBox with Selection Style 'Windows 
checkboxes' 

67134 Document Properties setting Allow Move/size does nothing 

67230 Invalid argument. QVAjax.js Code 0 Line:58 

67282 Possible to do search and select in bookmark object even if read-only is set on sheet 

67300 Desktop Client - Tab in Container Object is not hidden when Conditional Show is used 
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67385 QV crashes when the grid mode is turned on for container 

67460 Manual & Help: Japanese Translation of "Star is" example translates syntax such as 
Inline and ASTERISK 

67475 Colors Washing Out 

67505 Dimension Labels display is not as expected with horizontal, vertical & slant selections 

67557 Source control: When a List box is set to “Alternate state” other than inherited (or 
default state), the "Always One Selected Value” is lost 

67564 axis in vertical oriented bar chart does not scale properly 

67658 Straight table crashing QV.exe/not showing the full content of the object 

67755 AJAX - Clickable rectangle on the lower right junction of  X/Y scrollbars causes first 
value to be selected 

67840 QlikView Desktop - Wrong number format when first expression failed to evaluate 

67858 OpenDoc API: QVUser() does not return UserID 

67877 Mobile Client/AJAX: Input Box with variable and array of options blocks out digits 

67890 Horizontal Scroll Bar Erratic Behavior in AJAX 

67905 Combo chart: Incorrect axis format 

67932 Drill-down group and Cycle Group icons missing in the Ajax client. 

67937 Ajax/Hybrid: Touch Interface in IE10, IE11, not able to select 

67951 Number Format changes after Group is Cycled 

68002 Document bug: Missing information about Conditional option in chart properties 

68021 IPad app:  When App is suspended QlikView doesn’t prompt for login credentials. - iOS 
native 

68025 Access Point - Button to move between sheets is not rendering on Android Device. 

68051 Reload in QMC is not retaining sort order in straight table with a conditional expression 

68094 Cyclic button icon not showing after selection 

68113 Keyboard shortcuts and AJAX 

68121 Export to Excel doesn't work when "On BIFF Exports" option enabled 

68152 iOS Offline Client not compatible with FIPS - Client side code 

68203 Input Box- Drop-down disappears and allows for edit with predefined values only 
property enabled 

68204 Bar Chart: Dimension Label Drilldown Icon behavior is inconsistent with 2 dimensions 

68219 No expansion icon displayed in expression list in List Box Properties 

68226 Ajax / WebView: Chart object helptext does not shows in correct place 

68232 Desktop/IEPlugin is hanged when typing down cursor in input field 

68272 UI JP "Sort by Applicability" is not translated correctly in Japanese version of QlikView 

68383 Stagger Labels get truncated (moved to left) by using Cycle Groups 

68415 Small Device Version is hardcoded in htm and not changeable 

68429 Document bug: Help/manual description is wrong for plot color stype option 

68471 Desktop Client Documentation:  No documentation on WebView/Ajax Repository 
change especially drop down list 

68533 Ajax object properties: The sort option won't show in server object properties, if the 
dimension has default sort option "state". 

68535 Bar Chart: Not possible to show second dimension's label if the first dimension's label 
not shown 

68551 Documentation: The term "lasso selection" in help and manual is misleading 

68591 Bundle Loads use Restricted Characters in the URL / URL encoding with AJAX client 

68632 Error messages are misspelled: Occurred 

68637 Tooltip in AJAX stays stuck on screen 
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68642 AJAX - Container object - tab borders not visible 

68645 Document bug: There is not QlikView.txt in project folder from v11 

68648 Document bug: "The Schedule Service" in Desktop manual 7.4 Batch Execution 

68663 QV11_2_Licensing_SR8.pdf document needs update in QES 

68709 IE Plugin - Export - When exporting large data sets in CSV (QVO, XML, etc... ) from the 
Plugin will cause the server to consume a lot of memory, if canceled or closed it will 
keep running, relogging will make another session 

68715 Accesspoint hangs by Changing Category after session lost 

68757 Using SQRT(x) when x < 0, causes other fields in table to have random values every 
reload is performed. 

68765 AJAX - Tooltip fails to display 

68770 Dynamic Update not working with QVWS on different server and Ajax Client 

68792 Workbench div tag issue 

68801 AJAX - Section access dialogue does not submit form on "enter" press 

68806 Print Report - Stuck loading - Ajax /Plug-in/developer: Report never prints unless you 
make a selection on a ListBox. 

68842 Pivot not rendering if collapse dimension columns 

68848 Reduction based on Section Access may cause unwanted results in the Distributed 
Documents and should be used with caution. 

68858 SR7: recreating application using PRJ folder and CTRL+S (or clicking save button) failed 

68938 Dimension is treated as Drill-down Group on bar chart even if the dimension is not 
belong to the group 

68947 QVS Reload Engine added in QVPR causing huge amount of errors in the QMS log 

68955 AJAX: Multibox object sometimes shows the list in the incorrect position 

68960 Bar Chart Horizontal: Stagger Labels get truncated (moved to left) 

68961 AJAX Ghost image when moving Column straight pivot table in SR7 not is SR3 

68987 Ajax / IE Plugin: Button with Bookmark - Replace is not working 

68989 AJAX - Remove last document state fails to function 

69009 QVS: Unable to lease license with OEM license with tags NUMBER_OF_DOCUMENTS;x;; 
& LICENSE_LEASE;YES;; in LEF 

69011 Anonymous Bookmarks: Cannot save bookmarks with Window 2012 host operating 
system (Shared File) 

69065 Pivot tables with conditional dimensions and expressions freezing 

69069 QVConnect process hanging and no connect to statement is written in the document 
log SAP 

69085 AJAX - resizing column causes object to be resized even when locked 

69093 Server - ServerTempBookmarkDayTimeout Not Working As Expected 

69112 Hidden Script - Show Progress for Hidden script option not working as documented 
when disabled 

69121 Preload setting is gone after clicked apply button 

69130 OCX plugin in MFC project crashes when opening under Win8 environment 

69132 Section Access: OMIT not working with alternate states on a QlikView Server 

69135 ELSE statement produces unexpected error message 

69141 Script line error by clearing variable before EXIT Script 

69155 AJAX Text Object doesn't wrap text 

69157 Icon color is changed for a warning of a task in the QMC. 

69158 Stacked Bar Chart not show Values in Segment and Sum 

69159 Bubble Chart size is created by radius not the Area 
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69181 Chrome: Section Access login dialog has cosmetic problem 

69182 Use patterns instead of colors works for Bar Chart and Pie Chart but not for other 
charts. 

69192 AJAX: Bar chart: Drawing of chart failed internally 

69205 Undefined domain causes the QVS to hang 

69222 Open in Server, can´t select a document list. 

69224 IAS Server - AJAX - Open QVW in AccessPoint, click the browser's back button and try 
to open QVW again results in error: "Unexpected Exception Occurred" 

69228 Syntax checker not working, "Error expression" error displayed as "Allocated Memory 
Exceeded" error 

69231 WebServer: Not able to find document if more than one cluster is setup 

69233 Value changes in straight table when changing sort order 

69261 Field Name in Expression Definition causes "Allocated Memory Exceeded" Error 

69262 Exporting straight table takes much longer when using conditional dimensions 

69269 Radar chart displaying error when an expression contain both positive and negative 
values 

69271 Object Sort order changed after QlikView server reload 

69274 Task skipped with reason Trigger skipped (not the least load) despite QDS being a 
single machine 

69279 Shared file Cleaning TOOL - Parameter 5 doesn't work 

69281 Ajax: Language issue when Exporting to Excel or Printing an Object 

69282 AJAX: Right click menu does not disappear when left clicking on another object 

69283 Mobile: Preserve Scroll Position doesn't work in List Box on Android or iOS with 
Chrome/Safari 

69284 Desktop: Grid Chart in mini Pie Chart Style shows wrong values 

69288 AJAX client has issues showing text strings start with [3-byte] + [4-byte] Unicode 
Characters. 

69292 Charts inside a container display as an error character 

69293 Current selection box not showing invisible selection only in Chromes and Fire Fox 

69304 Dropdown icon shouldn't be appeared after selection made in pivot table 

69307 Ajax / WebView: 0 are not always shown in Tabs in Ajax 

69309 Sort by Expression doesn't work with AJAX using Section Access 

69315 Firefox: images have a small rounded frame at the corners 

69334 Desktop/IE-plugin: Straight table search icon's input box is located out of the sheet 

69346 cell borders transparency color won't keep the same color in Ajax 

69359 WebView/Ajax: Transparency for border around objects should be ignored (like 
desktop) 

69361 Session Collaboration Not Available 

69366 AJAX: layering issues with ListBox search 

69380 Browser right scrollbar is disappearing/flashing in Ajax 

69384 Apply button is not enabled (grayed out) when change the settings in Design Tab in 
User Preferences. 

69386 Release notes for 11.20 SR9 do not mention fix for Bug #69164: AJAX: Calendar dates 
not picked properly 

69392 Help: "Theme Maker..." and "Apply Theme..." buttons are not mentioned for the 
Layout tab 

69395 System Requirements has typo on page 3 

69397 Loading from QlikView generated QVD with 1 billion rows hangs while in 11.20 SR6+ 

69408 AJAX: Slider/Calendar Object Does Not Change Pointer On Hover Until Clicked 
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69410 Override Group Sort Order option not checked after closing/opening document 

69419 Conditional Show with smaller Container Box than Chart not working in Ajax 

69421 Slider with null in "Max Value" causes huge memory consumption when loaded into 
QVS 

69424 Radar chart shows "Positive and negative value in chart" when "Force 0" unticked 
without negative values 

69436 AJAX: Save and Send as attachment exported Excel results in *.aspx format 

69442 Ajax: Straight table , Cycle group menu not displayed with more than 15 dimensions 

69459 #Tabrow not found by extension 

69466 Re-save 11.20 SR4 document with Containers in SR5 or later format makes it hang 
upon opening it next time 

69469 Cleaning tool recognized OrphanEntries error but they are not 

69470 Reload successful in QV.exe although reload actually failed 

69472 Qv.exe no response while changing through Container box objects 

69487 WaitForIdle doesn't work properly using qvp connection 

69490 User can still resize columns in InputBox and Multibox in Web View with Move/Size 
Sheet Object disabled 

69491 Clear Icon Doesn't Clear Selections In AJAX 

69495 Statistics Box displays incorrect sum value with opening 2 similar QVWs at the same 
time 

69512 Out of the session and USAGE CALs error 

69516 AJAX - Pivot Table drop down selection missing for last dimension 

69521 Print and excel icons displayed using the wrong theme 

69529 Allow empty LDAP property fields 

69530 Negative value "bar offset" treated as positive when ValueList() using bar chart 

69531 Shared objects are broken when copied 

69535 Font color and formatting is not kept in reports 

69541 QlikviewManagementServcie - The document does not have a root element. 

69554 QMC - Document admins not able to open QMC 

69558 Excessive logging SE_LOG: User - GetGroups: DCName is empty. Fetching... 

69564 AJAX - Cell borders disappear for blank cells 

69566 Scroll bar in ListBox stops working 

69587 Scroll bar in Text Object become locked or nonfunctional 

69589 Reload Engine down when installed components on different machines without 
Publisher license 

69590 Mode()  returns incorrect value 

69591 Reference Manual does not clearly state that we require local Administrator 
membership for our Services 

69592 QMC help text on Configurable ODBC is wrong 

69599 Line Chart: Number labels on Y axis change from percentage to fixed decimal 

69600 Minichart within a straight table without dimension shows allocated memory 
exceeded 

69603 Slider bar doesn't match with numbers 

69604 Total Mode "first string" and "last string" in Straight Table gives unexpected result 

69611 Global search object functions does not work properly in AJAX 

69614 Show Value not working with Stacked Bar Chart 

69624 Current Selections Lock, Unlock and Clear buttons not visible 

69634 OnInput/OnChange macro fails in 11.20 SR9 AJAX (Worked in SR3) 
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69635 Method WaitForIdle is not working with IEPlugin 

69642 AJAX Rendering: Text clipping using Georgia Font only Fox/Chromes 

69653 Scheduled task doesn't show correct next run time value after editing 

69660 Pivot Table: applying bookmark doesn't apply change on field positions 

69670 Trend Line with exponential function is partly cut off 

69672 document crash when contains tons of expressions 

69676 Directory Service Connector config change not always taking effect if the connected 
server is slow to respond 

69677 Labels on fields in cyclic groups not being saved 

69682 Can't change Root Folders for QlikView Web Server 

69685 System Requirements 11.20 SR10 Copyright is 2014, it should be 2015 

69686 Pivot Table sort expression doesn't work correctly in QVS 

69694 Adding chart to container makes QlikView Desktop hang/crash 

69695 Small Device Version not working as expected with Fire Fox o Safari 

69812 Cyclic group not showing with three dimensions in a barchart 

69817 Scrollbar position not correct when activating sheet in AJAX and "Hide Tabrow" is 
activated. 

69820 IE Plugin: Container object hangs and blinks 

69859 Document bug: Japanese Help menu revision level is SR9 

69862 Variable in script causes abnormal use of ram during Task reload. 

69866 Reload Engine (not a service) is not presented even though online help says it should 
be 

69869 Searches from "Users" tab in QMC time out after hard coded 30 seconds 

69878 Updating/removing Trigger’s actions list where Frontend functions can’t be executed 
by backend trigger. 

69886 Browser is hanged by specific character in Ajax 

69890 Shared objects in both IE plugin and AJAX, shared to specific users, disappear after 
reload in SR9. 

69909 Ajax - Input Box - All rows affected when single value changed 

69911 Fast Change - You cannot switch from Pivot table back to Mekko chart in Ajax or 
WebView 

69922 iPad Text position is wrong 

69923 Screen size inconsistency in iPad mode (full browser) 

69927 Dropdown menu in a straight box does not group up selections in the top in AJAX 

69928 Zero Value showing in Combo Chart 

69932 Direct Discovery: Encountered Sharing Violation 

69936 IE and AJAX: User will select unwanted values using the Control key 

69945 Documentation Bug: Missing information for IIS Tunnel Configuration 

69948 Document chaining QV documents in the browser, Russian characters in links don´t 
work. 

69953 Objects with show conditional don't react when the "control" variable changes, see 
overlap of information. 

69956 Cannot pass Selections in URL when using WebTickets 

69962 QMC: Task that are finish still show as running 

69971 [Document Bug] Description for ZTest function is incorrect 

70213 Internal inconsistency type D 

70258 Straight table: Expression giving inconsistent results 

70381 AJAX: looking glass icon disappears with some colors 
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8 Bugs corrected in QV11.2 SR10 

 

ID Title 

61315 Android: Not possible to export to excel 

61939 Ajax Unexpected exception occurred! Trying to Open Properties of Shared Object by 
Other User under Repository>Objects 

62015 Caption's background color transparency setting is not applied correctly for some 
objects 

62246 Cell Values - Paste - Moving Columns - When moving a column to the left of data in a 
list box causes the pasting of a cell value to the column in front of it 

62281 Ajax Client uses Browser Authentication when open direct link when Alternate login 
page (web form) is set 

62410 AJAX/WebView: Edit expression window: scrollbar and drop down menu for 
Aggregation, Field, Function and Variable doesn't fit 

62550 Japanese Server Reference Manual: Release number incorrect 

62590 QlikView 11.20.11922 SR2 has stopped working error thrown when opening an 
application. 

62614 Drop Down Select In Pivot Table Shows Wrong Values 

62645 Drop Down Select In Pivot Table Shows blank data 

62701 MonthEnd returns incorrect value 

62731 Document freeze with Java Script Error in full browser mode 

62959 List box selections causes unexpected results on straight table 

63703 Pie Chart: "Values on Data Point" % Missing After Changing Font Size 

63722 Script file exporter saving filenames incorrectly 

63840 AJAX/mobile: command "tel:" for dialing a number does not work 

64329 WorkBench installation cannot connect to HTTPS web folder 

64386 Can´t print list from a multibox when not selecting any value 

64399 Desktop: CSV export inserts garbage char at 70,000th row w/ 2-byte data 

64432 Can´t select date in a calendar with the mouse, it will revert back to default date. 

64830 % label in pie chart disappear 

65080 Ajax/WebView - List box - Style LED/checkbox: In Ajax List boxes with LED enable, the 
checkbox overlap the letters. 

65137 Desktop Client / IE Plugin: Container Object with lot of rows not behaving as expected 
(WebView / Ajax Client) 

65350 Ajax/WebView - Pivot table within a container object- Header: Pivot table within a 
container object the Header disappear / blanks when you scroll horizontally the table. 

65451 Labels On Data Points 

65553 scrolling with highlight limit to size of multibox 

65718 Document bug: Search Object's Default Search Mode <use default> is mistranslated 
in Help 

65843 Stacked bar charts with sections too small to render breaks values on data points. 

65926 Bookmark for application fail to open 

65967 List Box Properties: 'Always one selected value' lost when used together with 'Show 
Alternatives' 

66030 AJAX on iPad: Search Object is showing as an "opened box" 

66103 Text Box in Containers not working correctly 

66144 Mouse input not recognized on Chrome on touch-enabled laptop 

66163 Access Point: Favicon.ico not showing in other browsers than IE 
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66704 Ajax/WebView: Memory usage spikes up after clearing selections if objects configures 
conditional show 

66845 Multibox Tab disappears when activating it in a container 

66926 API Guide: Remove 0=HTML,1=Text,2=Bitmap from param3 for ServerSideExportEx 

67055 Export to Excel from a pivot table gives junk values 

67141 Distribution Service: No Trigger works when more than one "On multiple event-
triggers" is set up in one task (AND / OR) 

67143 Ajax - URL/Link - Dark default color: The URL/Link text color is shows dark blue or 
purple color within Ajax client and won't obey the "text color" change. 

67218 Values will not follow the selections point in the multibox object. 

67279 Drill Down didn’t work if a dimension before is hidden 

67418 Container: charts in containers don’t always render correctly 

67426 Document Bug: Force Patterns instead of Colors in User Preferences incorrectly 
translated in Japanese 

67440 Inconsistent behavior of Dynamic Bookmark based on locked selections 

67461 Desktop - Opening and closing qv.exe while splash screen visible causes qv.exe to 
crash 

67504 Bar Chart "Drawing of chart failed internally" Error when use IEplugin 

67506 Desktop Client: Variable Event Trigger > OnChange >Activate Sheet causes freeze 

67588 Not able to set background color of Multi Box 

67891 Current Selections drop down box does not display selections in the correct sorting 
order in Ajax 

67903 Security Concern: Removing HTTP Header information 

67906 Direct Discovery: Table box displays "Direct query failed" when making selection 

67919 Small devices version - Bookmarks - gauges - IPad/IPhone: when user use small 
devices with IPad or IPhone, when user selects a bookmark that involves a gauge 
object, when user views the gauges it loses the perspective or disappears (blank 
page). 

67922 AJAX - 'IS_IE' is undefined Error In Internet Explorer 10 After Adding or Deleting 
Bookmark 

67983 Certificate communication on Windows Server 2012. Restarting QlikView Services can 
cause the server to reboot itself 

68000 Problem to change order for a dimension in a straight table in Chrome. 

68017 AccessPoint - Vertical Alignment on data points not working on Scatter chart 

68107 QV Desktop: Help > QlikView on the web > Support opens an internal URL 

68163 Desktop - Copy Button displays in Right-click menu when copy object privileges have 
been restricted 

68164 Listbox background with IE8 AJAX 

68229 Docu Bug: QVD Load 

68346 Juxtaposed texts and images do not render properly in iOS app 

68361 Juxtaposed texts and images do not render properly in AJAX using mobile Safari 

68385 Internet Explorer Plugin unable to process 'Transfer State' option in Open QlikView 
Document Action 

68394 Cannot find any information on "Importing QVD with asterisks are not supported 
since 11.20" 

68419 AJAX client cannot show characters in Unicode CJK Extension B (C++) 

68525 Ajax: Pivot Header Alignment hide label 

68527 Listbox not updating after selections has been made from button with triggers 

68570 Chart properties box leads to unresponsive session 
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68615 Images are missing when using IE11/Ajax 

68636 AJAX - ListBox - LED checkboxes display right border even though no border width 0 
pt. is configured 

68640 Duplicate queries sent by Direct Discovery 

68690 Desktop Client: Unable to expand (+) documents in Open in Server through Start 
Page, window close 

68726 Selections not retained with IE plugin 

68732 Bookmark URL (Email) in clustered environment points at server not cluster 

68767 Sheet Navigation Stripe cut off in case of using the drop down menu 

68800 AJAX IE8 Listbox Background Not Loaded Completely 

68872 [Document Bug/Enhancement]Small device version does not have sheet concept is 
not mentioned in Reference Manual/Help File 

68919 Publisher / QMC - Reduce tab - Open document - loading: When you try to open a 
document in publisher create task > reduce tab > open document, QMC gets stuck 
"loading...Please wait" and apply button is grayed out. 

68965 QV InitWorkBench truncates ticket 

68969 Japanese character garbled in the "invited collaboration session screen" 

68990 AJAX - TabRow Expands Vertically and Horizontally (depends on browser) and Pushes 
Sheet Down Temporarily + Flash on Screen 

68992 Gif animations not working in desktop client SR6 and upwards. 

68994 Part of Object calendar icon cropped in WebView 

69012 Pop up text on scatter chart not show 

69013 Table border disappearing when scroll bar moved up & down. 

69023 Documentation bug - QV for iPad offline mode issue - bookmarks list does not get 
dynamically updated 

69025 [Text as Pop-up] in [Chart Properties] -> [Expressions] doesn't pop up custom 
message since QV11.2 SR7 

69031 Excessive logging SE_LOG: OpenFileOrURL: An exception (filepath) contains an 
incorrect path.) occurred during open of  (filepath) 

69036 Fixed record script gets highlighted by syntax check 

69039 Documentation: Explanation for Alternate State parameter “GetSelectedCount()”, 
“GetFieldSelections()” and “GetCurrentSelections()” is missing in Reference Manual 
and Help 

69052 AJAX - Input Box - drop down arrow selector disappears 

69058 When loading a numeric field from a QVD file with a GROUP BY clause where the field 
participates, the field has no string representation. 

69079 Documentation: Effect of combining distinct and non-distinct tables 

69094 [Custom Pop up text] will not show up when hovering on lines in combochart 

69113 Bookmark: Share for individual user not showing up 

69124 QlikViewServer - Warning SE_LOG: Shared - ApplyBM: Could not update the Recall 
time on bookmark with id: " is always printed 

69127 Document Chaining not transferring selections in Open In Server 

69128 FitZoom / ApplyZoomToAllSheets macro looping in QlikView Desktop Client "Open in 
Server…" 

69161 GetCurrentField does not expand the group value if using calculated dimensions 

69163 Sort fields by Load Order on Direct Discovery table window's down unexpectedly 

69174 Calendar Object not working if based on an expression 

69180 Chrome - Calendar Object not displaying correctly 

69215 AJAX - Horizontal scroll bar jumps to beginning on pivot table inside a container 
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69221 Cyclic group icon giving a QVAjax.js error 

69491 Clear Icon Doesn't Clear Selections In AJAX 

69613 Desktop and Plugin Client: Client initial refresh. If old date not kept in server or client 
too old, refresh will be performed automatically cause "Server connection lost, 
closing document!" 

69634 OnInput/OnChange macro fails in 11.20 SR9 AJAX (Worked in SR3) 
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9 Bugs corrected in QV11.2 SR9 

ID Title 

42783 Use Column Labels-> "Field" doesn't work correctly(IE7) 

43617 Minimized chart is restored when open from in Ajax 

44947 Desktop: Unable to open application in WebView with double click on qvw 

45037 Dimension Limits - Show Total in Bar Chart does not properly scale axis 

45744 Japanese Translation Straight Table>Presentation: Horizontal Different 
Manual/Help/Product 

48643 Selecting "Advanced mode" in Scatter chart Expressions tab shows Sort tab instead of 
"Advanced mode" 

52524 App can't restore with prj Folder 

54116 Low verbosity on Eventlog, still a lot of entries of Mount browsing 

57493 Variable for font color doesn't work in Chart Legend 

58769 Source Control Settings errors out in Windows Server 2003 

60068 Server - unable to remove a node in QMC when the QVS node is offline 

62220 Holding down shift key does not select multiple values in AJAX client 

62515 QMC: deleted assigned CAL under User tab cannot be restored by undo delete icon 
and apply 

62519 Annotations stays in the shared file even though chart is deleted 

63424 Invalid Machine ID corrupt PGO File 

63741 Advanced search expression is not restored from bookmark 

64440 No Publisher: Removing task that referred in "On Event from Another Task" will leave 
orphan task 

64621 QMC: Trigger On a schedule > Monthly > Days or On + Last is not working as expected 

65205 Starting 2 batch-tasks that will start on the same task to success, one batch-task fails 
every time 

65453 Run Continuously option not available in QlikView Server with Publisher 

65616 QMC: cannot open document to set up loop and reduce task 

65858 The shared file was broken when it is over 4GB 

66614 Desktop Client fails gives error on Update Check 

66744 Input fields are not loaded from shared file 

67180 AccessPoint Download Double byte Document Name Garbled in the Download 
Window 

67255 Trigger "copy State Content"  (Default State to Alternate State) with Section Access 
causes corrupts the App 

67317 QV11.20SR4: Dynamic Update statement fails when Table has only a single row 

67413 AccessPoint No Server or No Preview Available if Root Folder name is in Japanese and 
there is a certain number of QVWs 

67493 QVS - Shared file causes server to max CPU/RAM but shows no errors in cleaner tool 

67591 IPad app: Charts not loading in offline mode 

67661 QlikView web service log file System.Exception Errors do not parse well in QlikView 
File Wizard of Script Editor 

67665 Plugin is hanged when clicked back button on the browser with Direct Discovery 2.0 

67767 Documentation update Certificate Trust 

67774 Field Event Trigger: Selection is not deselected 

67852 Clear button makes memory RAM increases rapidly making QVS crash 

67861 batch started task doesn't send alert emails 
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67929 Cannot customize <LogoutAddress> in QlikView WebServer config.xml 

67979 IE-plugin: Scroll down searched list box shows "X" 

67987 Desktop Client: Variable Event Trigger > OnChange >Clear Field issue 

68055 Mobile manual should more specific Landscape mode orientation 

68120 Cycle buttons change wrong expression, if you have another cycle button hidden in 
the chart. 

68127 Interactive Sort in Straight Table Columns generate “Allocated memory exceeded" 

68168 QDS root logs indefinitely when access to task log folder path is denied, resulting in 
disk space exhaustion 

68294 Japanese is changed to Unicode when saved as XML format 

68313 Direct Discovery problem with calculated dimensions 

68317 Bar chart data point value is not truncated correctly when Thousand Symbol is set 

68327 Prints and PDFs for Sparkline Minicharts are too low quality 

68371 Allocated memory exceeded error on chart 

68448 11.2 SR6 QV Desktop Crashing When Trying to Enter "Log in as specific user" 
Password 

68457 Scrollbar misplaced when activating another sheet in AJAX 

68503 Not rendered accordingly for right axis in bar chart 

68515 IE-plugin: Mail with Bookmark as a Link does not work with Japanese name QVW 

68538 Documentation: "Use Regional Settings for HTML export" 

68548 Desktop/IEPlugin Memory Issue Application Freeze or Session Lost after Some 
Selections Made with Set Reference 

68555 Image disappear when publishing the report if I use brackets in the doc name. 

68562 QVS generates excessive logging while in WorkingSet limits. Event 500 Warning 
WorkingSet: Critical RAM overload. 

68564 AJAX/WebView: Tab (tabbing) between Input Fields and Input Boxes does not work 

68573 Ajax - sheet background images - cutoff: When a sheet has an images for background, 
if the sheet requires to scroll down the window, the image will be cut off in Ajax 
client. 

68574 QDS - Alert E-mail - line break: If the Alert E-mail recipient got a line break (press 
"enter" to move to the next line) it won't send the email alert to the recipients after 
the break. 

68578 QVX file created by STORE command contains unexpected <LittleEndian> element 

68587 Release notes: Cleaning Tool 

68613 Desktop client crash when trying to edit or print a report including hidden objects 

68619 Visual Cue (with color red) or Expression with Textformat RGB(255,0,0) print as black 

68620 QMC does not refresh the summary when Document CALs are applied 

68624 Ajax - Calendar object Widget: The calendar widget won't stay open in Ajax. 

68630 Document Chaining Transfer state not working after 2nd or 3rd chain - AJAX 

68635 EDX task - Publisher - Nested tasks: Errors occur with EDX automation when jobs 
contain sub or nested tasks 

68668 All objects are resized simultaneously if SHIFT key is hold and a chart is resized 

68672 Desktop Client: Changing size of Container in Container (nested) in Grid Style will not 
resize and overlap 

68673 Recreating a QVW from PRJ folder not retaining Document property settings 

68675 Cannot open document in QMC SR7 to Loop and Reduce 

68678 Remove last document state without functionality 

68691 Server is not responding due to a long-running script, AJAX,  SR7 
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68692 QMC: Sort order of "On event from another task", "On multiple events completed" 
and "Task Dependencies are different when using 0 as leading number 

68694 QMC: Unable to add/change Task name/Task Description after a Trigger has been 
added in Internet Explorer 11 

68698 Data Discovery with WebView hangs 

68703 Opening reloaded application takes down QlikView Server in SR6 and SR7, works fine 
in SR5 

68706 Developer x86 Does Not Read QVX Files 

68711 Documentation: There is no documentation to Task performance summary and 
Release Notes are not good written 

68716 Source Document Folder Mounts - interacting with white space deletes mounts! 

68728 Search window shifts to left if list box is wide 

68744 SR7 PRJ File Causes Container Object to not Display 

68778 When trying to open variable overview in desktop client, desktop client crashes. 

68845 Report containing objects with unfulfilled calculation condition will cause QV.exe to 
freeze/crash or the report will be uneditable 

68851 Desktop objects in container not shown 

69164 AJAX: Calendar dates not picked properly 

69322 AJAX: application becomes unresponsive in IE 10 - session must be closed 
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10 Bugs corrected in QV11.2 SR8 

ID Title 

42565 Check the "Preserve Scroll Position" checkbox does no difference on bar chart 

42579 Desktop - Drop down select in straight or pivot table will appear in wrong position if 
window is scrolled 

42629 Tab row can't be enabled in WebView 

42683 If the chart object shows ' Too few expressions' or could not be drawn the fast type 
change icon is showing as a drop down 

42702 Background Color "Transparency" is set as 100. Which is not consistent with default 
setting of other objects' transparency. 

42802 Developer - horizontal scroll bar overlays x-axis dimension 

42831 Dragging an expression into another charts properties gives an exception. 

43621 Minimized container still possible to move with Allow move/size unchecked 

43642 QMC: Management service setup - SQL repository - explanation text continues 
outside frame 

43668 Property windows, Repository window, Add New Sheet Object window jumped left 
whenever moved (drag to new place) 

43679 Links in straight and pivot table starting with www does not work 

46451 IE - AJAX - Drill down menu not showing blank option 

47961 Changing owner on a server bookmark does not apply correctly in the .shared file 

48411 Ajax As Scroll Bar is at the Bottom, Chart does Not Appear 

48975 Method WaitForIdle  is not working with IEPlugin, It work with Desktop 

52874 Documentation: Statistics Chart Wizard - Location of the Wizard incorrect on the 
documentation 

57353 WildCard (*) not working correctly 

57473 Empty cyclic group restarts the session 

60204 QMS: When QMS is not able to read XML task remain in running, but they are 
finished 

60263 Ajax: No Help Text in popup in a Button Object 

60658 Ctrl+selection in a ListBox in Ajax on a mac will lock up the document. 

62055 QlikView Management Console: Need to remove the wording that Groups can be 
added as document administrators GUI 

65266 Using Select button when connecting to Informix database crashes QlikView (with 
ODBC driver version > 3.50) 

65740 Copy to Clipboard - Cell Value 

66115 QMC Webserver Authentication: Inconsistency of selecting Custom Login Page > Text 
field 

66150 Manual: Some functions are missing, some functions appears twice 

66709 Data values change depending on loaded order 

66777 Icon font color in caption not working in IE7 

67405 QlikView Ajax & "Edit Expression" in the properties of a list box 

67542 SAP Connector fails to read due to max no of 100 conversations exceeded 

67568 Document bug - Support version of QlikView for iOS 

67594 Fixed length data isn't interpreted correctly in 11.20 SR4 Up1 

67671 IE9 - AJAX/WebView - Text Object - Background color - When viewed in AJAX or 
WebView background colors for a text object disappear (removed) 

67703 Graceful refresh causes the QVS to restart for a specific document 
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67784 Document bug:  In Load Script, colon in alias names are no longer valid in 11.00 IR or 
later and has to enclosed by [] brackets. This should be mentioned in Release Notes, 
Manual and/or Help. 

67789 Documentation: Documentation of stored content in Bookmarks is missing 

67801 After applying a bookmark, not all selections shown in current selections box 

67825 Mobile - iOS 2.0 - Password - Lockout - Logging into the iOS application with the 
wrong password will cause 3 failed login attempts instead of 1 

67846 [Document] Add comment "not to use identical names between field, variable and 
column" 

67850 QMS API call GetUserDocumentNodes fails when folder contains large amount of 
items 

67899 Documentation: Default Export Options>No Thousand Separator for exporting to 
Excel 

67927 QMS - QMS log becomes huge when SQL fails (>1GB) But no other indication is given 
that something is wrong 

67941 Documentation: Reference Manual: Data structure changes affecting bookmarks 

67969 Documentation: Description of Error Mode in manual/help 

67993 Export buttons no longer show in AJAX 

68031 Documentation: Manual is not clear on how Preserve Scroll Bar Position is applied. 

68051 Reload in QMC is not retaining sort order in straight table with a conditional 
expression 

68078 iOS Offline Client not compatible with FIPS - Server side code 

68099 Input fields are updated with the wrong values when opening the QVW in Ajax (C++) 

68109 Server Reference manual warning message before apply publisher license to prevent 
task lost 

68140 GetCurrentSelections() fails on the server when we add Section Access and omit 
field(s) 

68141 General Script error when doing numerical expansion after EXIT Script 

68142 Windows RemoteApp - Developer - Calendars: QlikView Developer crashes, when you 
select the Calendars object within Windows RemoteApp. 

68144 "IE cannot display the webpage" error when re-login AccessPoint using the alternate 
login page after session Timeout 

68151 Documentation: QlikViewPDF doesn't exist and isn't downloadable separately 

68153 Plugin hangs occasionally in certain conditions 

68154 Inconsistent Data from Set Analysis Expression. 

68175 Connection busy with results for another hstmt 

68185 Using Report Editor on a specific QVW file crashes QV Desktop 

68186 Desktop Client: Values on Data Point are not shown correctly in vertical stacked bar 
chart with negative values 

68192 Documentation - QMC help - Reload Engine: Need to be clearer what services will 
show when (no publisher) reload engine is only available. 

68198 Desktop - Getting Started Wizard - Drag and drop Xls: When user drags and drop a 
XLS file in the stated wizard of developer the "next step" button is grayed out. 

68199 Ajax-WebView with desktop client multiline header alignment is to top only 

68209 Internet Explorer - IE8 - Check boxes - Labels - The label for a checkbox in IE8 is blank, 
but other browsers show the label fine 

68215 WebView/Ajax: Line break in table cells does not work 

68236 AJAX: Undefined displayed in empty InputBox when user clicks in it 

68261 Ajax, cannot make multiple selections of days for calendar object 

68280 SAP extractor shifts fields using tRFC 
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68303 Documentation: GetFieldSelections() description is misleading 

68305 Container objects blinks in Desktop/Plugin 

68308 AJAX IE8 - users get "Invalid Argument" error 

68309 Custom messages in 11.20 SR4  not aligned correctly in 11.20 SR5 

68311 Expression calculations differ from a textbox to a "text in chart" within a Gauge Chart 

68322 Image inside the document disappear when the QlikView application has an 
apostrophe in its name 

68330 Cycle buttons change wrong expression, if you have another cycle button disabled in 
the chart. 

68373 Input values lost when stopping and starting QlikViewServer service when Set 
Analysis, Inputsum and alternate state are used together 

68397 Scatter chart: Advanced mode is wrong at first creation 

68417 AJAX - Conditional Show on Tabs does not Display Correctly 

68477 Returned wrong result when using ApplyMap function 

68686 Listbox: incorrect data generated if use Expression in v11.20 SR7 
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11 Bugs corrected in QV11.2 SR7 

44327 Line break in list box using LED selection boxes 

44332 Ajax Mail with Bookmark as a Link is Active Although Server Object Setting is Disabled 

44731 Layout Problems in Ajax caused by shared File with many added and deleted objects 

45058 Server - pivot table with conditional dimension not pivoting horizontally 

45684 Properties window falls behind all other charts (Chrome) 

46186 AJAX - Pivot Table +/- position in the middle of the cell 

47590 (Ajax/WebView) Image representation and hide text when image is missing behaving 
as in Qv 

48086 Statistics boxes do not allow selection in AJAX client 

48284 AJAX Combo charts and list box not working as expected 

48373 Developer - Lineage info retaining information 

48418 WebView/Ajax generate a QvAjax.js error message with a specific .qvw file 

48686 Dropdown in button properties is not "in front" 

48741 Rounded Corners unchecking themselves 

48967 Ajax Set Clear State  Results in Clearing Selections 

49113 Ajax IE8 By Clicking the Background, Main Tab Becomes Active 

49726 Colon character use in Ajax causes return to previous state 

51403 Ajax: Chart not fully rendered 

56549 Plugin - Container object with chart - Scroll Bar is missing from the chart 

56762 Ajax - Edit Expression on an Object:  When editing an Expression, the drop-down 
opens and then closes immediately, thus making it impossible to select a value. 

56947 Ajax - Transparency option for sheet tab color does not work 

61120 iPad app can't access server with Alternate Login Page 

61982 Dimension Limits not limiting as expected in block charts 

62221 Pie Chart Print issue: Legend is not in correct position 

62359 QDS Debug Logging not writing Windows Events 

63236 Desktop - Locked field locked using macro or action - unlocked after Reload 

63735 Over 70 folder mounts causes QMC instability 

63877 Cycle Button Does Not Move When Chart is Maximized 

63891 Shared file causes QlikView Server service to have high CPU utilization even after the 
associated QlikView App is closed 

64333 The QVS tries to read pgo file but fails because it is locked by another QVS 

64505 AJAX - Document chaining bad performance 

65068 Bookmark sending by mail fails on IE plugin when the QVWS and the QVS are on 
different machine 

65792 Pie chart with two dimensions, inner dimension values are not shown correctly 

66267 apiClient.GetSourceDocuments(qdsID);  Returns sometimes all Documents for 
Document Folder Administrator 

66768 Content of some objects ends up outside the object area when resizing (smaller) 

66838 QVS doesn't preload the QVW just after reload. 

66979 Sheet ID - AJAX - Special Characters: WebView error message "Script Error: Syntax 
error, unrecognized expression" when the sheet ID has a special character 

67049 Hierarchy load generates too many records 

67195 Distribution without Reduce creates temp file adding supplementary time duration to 
task. 

67268 Pop up/Hover Over Stacked Chart Shows Improper Grouping for Expressions 
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67395 Shared File - AJAX - Session Lost - Large Shared file that worked in 11.20 SR3 causes 
AJAX to trigger a Session lost when used in 11.20 SR4 

67404 API function apiClient.GetTaskStatusNodes returns different values randomly 

67425 Radar chart - Tick mark missing for negative values - QV 11 

67432 Background Images are not shown in Ajax if .QVW file name with  contains a round 
parenthesis ( or ) 

67437 Easter egg: ServerTempBookmarkDayTimeout doesn't work anymore 

67442 QVConnect.exe crashing when connector logging active 

67487 Table data is not displayed 

67549 Copy and Paste No Longer Available 

67551 Calling a document that Direct Discovery script is failing with Server crash. 

67563 IOS Client Failed to open document when document title contains Cyrillic characters 

67598 QMC: simple reduce fails to pick the right values 

67629 AJAX: Dimensions in pivot table disappear when document and pivot table is updated 

67634 Listbox with "Size to data" not sizing properly in Ajax. 

67662 Ajax/WebView: if the object is  Transparency 100%, the bottom object is clickable 

67703 Graceful refresh causes the QVS to restart for a specific document 

67706 Server - MaxReceivedMessageSize not allowing large log files to be viewed in the 
management console 

67744 Mail with Bookmark as link creates incorrect URL when using IEplugin through HTTPS 
webserver - Generates "HTTP" URL instead of HTTPS 

67792 QMC - Monthly trigger - GUI Fields overlap 

67824 Direct Discovery: Unexpected data seen in chart 

67826 Small device (mobile) view doesn't show all the table contents 

67838 AJAX: Cannot drag and drop Expressions from the Repository into objects 

67859 AJAX - Multibox - Always One Selected Value - Deselection Turns Multibox White 
Instead of Green; Shows in Current Selections as Selected 

67924 Calendar: in AJAX/WebView, right-clicking on expanded calendar displays the sheet 
properties menu in the back 

67950 Not possible to add connection QVS on other server when using certificates 

67954 Reloaded wrong data with Japanese JIS used "|" as a delimiter 

67965 SNMP Functionality and Restrictions not documented accordingly 

67976 AJAX - Scaling and Positioning of objects (text objects, list boxes, ..) incorrect - leads 
to overlap 

67985 11.2 SR5 Degrade - Concatenate in combination with SUM and $ expansion of 
variables in the script 

67999 Ajax - Export to excel The requested content has opened in another window Pop Up 

68029 Unable to define days in weekly triggers for supporting tasks in 11.20 SR4 

68035 Parallel Loop and Reduce tasks could trigger Windows RPC stall 

68037 Desktop Client/Server: General Script error after update to 11.20 SR 6 

68049 Applying Transfer State in a document chain causes freeze 

68050 AJAX/WebView: Problems using Windows checkbox style with Internet Explorer 8 

68052 Document publisher reload - Binary reload - Takes longer to execute: When a 
Document reloads in V11.2 SR4 or SR5 and it is executing a Binary reload, this take 10 
- 20 times longer to complete comparing older versions. 

68118 AJAX - Current selection box not showing all items when first item is word wrapping 
more than 3 lines 

68126 QVS goes into idle mode 

68134 Ajax: Text in input box should be selected when clicking on it 



Bugs corrected in QV11.2 SR7 

39 
 

68159 Always One selected causes reload to hang 
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12   Shared file Cleaning TOOL  

QlikView are pleased to announce that a new shared file Cleaning Tool is now included in the QlikView 

Server executable. This will allow system administrators to analyze (verify) and repair (purge) the 

QlikView document shared files easily and effectively simply by running a command line execution of 

QVS.exe with special parameters.   The server administrator will then have the option of using the 

purged shared file, or retaining the old shared file. 

 

12.1 How-to Instructions:  

There are two modes available with the Cleaning Tool, each specified by a different command-line 

parameter. The first mode is called VERIFY and the second mode is called PURGE. 

 

-VERIFY: By using the parameter -v the Cleaning Tool will analyze the shared file specified in the 

command-line, and create a report detailing the results of the analysis performed against your shared file. 

If during the analysis the tool detects there is one or more INVALID/CORRUPTED object entries, in the 

shared file, the QVS will log as much information as possible around the INVALID entries. 

-PURGE: By using the parameter -p, the cleaning tool will verify the shared file, and then also create a 

brand new version of their SharedFile with corrupt entries removed. This clean version of the SharedFile 

will be placed into the same folder where the original SharedFile is located.   The new file will be called 

MYFILE.QVW.Shared_clean, and the original shared file will not be overwritten.   The server 

administrator can then make a decision to replace the original shared file with the new, clean shared file. 

The format of the command that users have to type into the Command Prompt for using the SharedFile 

cleaning tool is the following: 

C :\>     < Folder path where the QVS is placed + “\QVS.exe” >  < -x >  < Folder path + \Name of 

the SharedFile > <Cleaning Tool Mode> -l  <Log Folder path> 

Parameter 1:  The path where the QVS.exe file is located in your system folder, plus, the name of the 

file to be executed, in this case, QVS.exe. All text must be placed in double quotes. 

Parameter 2: By entering –x, as a parameter within the command, users are telling the QVS that they 

want to run the SharedFile Cleaning Tool only. This will not start the QVS service in “normal” mode, an 

instance of QVS will start, run the cleaning process then shut down. 

Parameter 3: Path where the SharedFile to be cleaned is located, in your system folder, plus the name of 

the SharedFile itself. All text must be enclosed in double quotes. 

Parameter 4: If user wants to execute the tool in VERIFY mode, use parameter -v.   To clean the shared 

file, use parameter -p to create a new copy of the shared file, with corrupt entries removed. 

Parameter 5: Optional, if you want to change folder for the log file. 

 

12.2 Step by step instructions 

 

1. Make backups of your shared files before proceeding. 

2. Locate your copy of QVS.exe. By default that will be in C:\Program Files\QlikView\Server and 

make a copy of it. Place the copy in a different folder, for example C:\Temp. 

3. Determine which shared file you wish to analyze (verify) and if necessary, repair (purge). 

4. Open a command prompt (run as Administrator). 
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5. To verify the shared file, enter the appropriate command line as below C:\> “C:\Temp\QVS.exe”   

–x    “C:\ProgramData\QlikTech\Documents\FinanceAnalysis.qvw.Shared” –v

 

6. Locate the verify file log – the file will be called CleaningTool_MACHINENAME.log and be 

placed together with the other server logs.    The log will list each type of shared file object if 

there is corruption.   If the corrupt entry can be identified, it will list the object ID.   

 

7. If there are corrupt entries, we recommend that you PURGE the shared file.    Rerun the command 

line as above, and change the last parameter from –v to –p.   C:\> “C:\Temp\QVS.exe”   –x    

“C:\ProgramData\QlikTech\Documents\FinanceAnalysis.qvw.Shared” –p 

8. The purge process will create a new shared file, with corrupt objects removed or corrected.   Note 

the resulting file may be larger than the source file.    The new file will be placed in the same 

folder as the source shared file, but will be called MYFILENAME.QVW.Shared_clean.    The 

original source shared file will be remain in place. 

9. Rerun the verify stage again, remember that the “new” clean file is called 

MYFILENAME.QVW.shared_clean, so adjust your command line accordingly, otherwise you 

will just re-verify the old corrupt file again. 

10. Locate the verify log.    It should now be clean and have no corrupt entries. 

 

11. Finally, replace the old corrupt shared file with the new file.    Do this when the file is not in use 

(i.e. there are no users accessing the application on the server).    Rename the old shared file, 

and copy the new shared file.   The correct name should be MYFILENAME.QVW.Shared. 
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12.3 Warnings and Tips 

- Any time you run the cleaning tool against a SharedFile, new lines will be added to the 

CleaningTool_MACHINENAME.log file.  

- Make backups of your shared files before running the cleaning tool. 

- In production environments where the existing QVS is very busy, copy the QVS.exe file to a temporary 

folder, and execute the command line against the second QVS.exe file. 

- Make sure, before running the cleaning tool, that you have permissions for creating files within both 

folders. The one where the report file is going to be saved and the other one where the clean version of 

the SharedFile is going to be saved. 

- The user must run the QVS.exe process with administrator privileges. In case you are experiencing 

issues when trying to running the tool, please, try going into the properties dialog of the QVS.exe file 

(right-click on it),  and CHECK-ON the box “Run this program as an administrator”, in Compatibility 

tab. 

- If you have any questions please contact Support, and they will help you out as soon as possible. 


